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Richard Cousineau C.E.T.

Calendar

The new season has already started with many planned
events and outings.

Nov 14

The mentoring program is off to a great start and hopefully
the great November weather will encourage many more
local hikes for all to put in practice what Ron and many others
are teaching everyone. Get out there and take some great
landscapes, foliage, birds and photos of friends and family.

Nov 18

I’ve been busy with my marathon training the last few months
and now that’s off the bucket list I hope to get my camera out
more often and lead more mentoring hikes.
Macro and wildlife photography are two main genres I like
to shoot but hope to learn more on flash and portraiture this
coming season. The upcoming flash workshop is one I can’t
wait to participate in. Michael Willems hands on workshops
are ones not to miss.
Regards,
Richard Cousineau C.E.T.

Nov 25

Dec 1
Dec 4

Dec 11

APC Workshop:
Creative Hands On Off Camera Flash with
Michael Willems
APC Photo Class:
Composition Part 2:
Learning to Apply

APC Photo Class:
Composition Review
and Photo Critiquing

APC Member Meeting:
Margaret Hines

APC Xmas Dinner & Fun
Competition at Deer
Creek Golf Club
APC Fun Social & Photo
Feedback Night at
Debbie’s Boutique Cafe
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APC Member Meeting:
Tuesday, December 1, 2015
with Keynote Presenter
Margaret Hines
Artist Statement

To photograph underwater is a unique, challenging
and ultimately satisfying experience for me as a
photographic artist. There is an element of uncertainty
when photographing underwater due to the very nature
of water, the technical requirements, and the realization
that being totally submerged is not a natural state for
people. Time and place are suspended underwater,
watching the play of light, flow of the human form and
fabrics make for an ethereal experience controlled by
the subject’s movement, patience, camera settings and
artificial lighting. Images are captured in-camera with
post-production in Photoshop to correct backscatter and
debris floating in the water. I never cease to be amazed
by the untold beauty offered by such a simple element as
water, this precious resource sustains and nourishes us.
The natural beauty offered beneath the surface of all the
Earth’s waters fascinates and inspires me.

Biography

Margaret began exploring photography as a
creative hobby in 2004 and is completely self-taught
photographically and in post-production editing printing.
After a varied career in accounting and aesthetics, she
decided to focus on photography full time in 2007. Her
early ventures included shooting weddings, nature,
portraiture, landscapes and macro but her perspective
and creative interests changed profoundly after
discovering the imaginative underwater works created by
Howard Shatz (New York) and Zena Holloway (London).
The amazing ethereal enthralled her, flowing weightless
quality and wonderful play of light offered by the
underwater environment that no studio setting could ever
replicate. And, since so few Canadian photographers were
working in this medium, she knew there was a fine art
niche here just waiting to be explored and filled.
Ontario doesn’t enjoy salt water (excepting frigid Hudson
Bay), but is home to one-third of the world’s fresh water in
its quarter-million lakes. Unfortunately, most of these are
too inaccessible, cold and lack the pristine clarity required
for her particular style of work.
Not a problem, since the home she and her husband Rod
have in Whitby, Ontario just east of Toronto happened to
come with a 20 by 40 foot heated in ground pool, a madeto-order ‘Studio’ ready for action. Since the pool studio
season is only during May to October in Ontario, Margaret
spends the remaining six months of the year creating the
costuming, props, etc. for next years’ underwater sessions
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as well as creating fine art composite images in her small
indoor studio. Margaret literally jumped in with both feet,
and finds she is continually learning as her shoots become
increasingly creative, complex and far more challenging
technically. She has focused exclusively on her underwater
work with the occasional foray into fine art composite
work during the winter months when the underwater
studio is closed.

2015 Awards + Achievements:

• Vistek Canada National Gallery February December 2015
• Vistek Canada Blog article -‘ What Lies Beneath’
• Vistek Canada Blog article - “How to Make Gallery
Quality Prints’-Awarded Craftsman of Photographic Arts
(CPA), Professional Photographers of Canada (PPOC)
• PPOC Certified Judge - Regional Image Salons
• Featured in Vistek Canada cover ads for Epson Canada
printers (Applied Arts
and Scotiabank Contact
magazines)
• One Eyeland Awards:
Bronze (Fine Art/Other
Category) for ‘Tiny
Dancer’
• Appointed a Canadian
Ambassador for Ikelite
Underwater Systems
• Exhibitor at Sony’s
PHOTOGraphie Open
Gallery Exhibition
• Guest speaker Ajax
Photography Club
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Sports Photography
with Angela McMullen
Why Buy a Monopod?

Someone asked me the other day why I owned a
monopod and when I use it. Wouldn’t it be better to
simply buy a tripod when you need to stabilize your
camera to get a shot? Every photographer should
own a tripod – especially when shooting landscapes
– but sports photographers know that a monopod is
indispensable when you’re shooting with a long lens.
Not only does a monopod help carry the weight of your
lens and camera (great if the game goes into overtime),
it also helps to reduce the chance of a blurry image
even when shooting at fast shutter speeds.
With only one “leg” a monopod is more mobile than
a tripod and tracking a moving subject is simple once
you get some practice. You can purchase a ball head
for your monopod (and if you stick with one system
or brand, it will be interchangeable with your tripod)
which allows you to change from horizontal to vertical
orientations quickly; however, many professional sports
photographers use a static head that doesn’t move –
the only adjustment is the height of the monopod, and
of course, the ability to move from side to side and
back and forth easily. No fussing or fumbling, just
getting the shot.
Personally, my monopod is always with me when
photographing sports – especially hockey. In low light
conditions, my monopod helps me capture sharp
images even when I’m shooting as slow as 1/400 of a
second. And in sports photography, 1/400 is mighty
slow indeed.

Photography by Angela McMullen

Angela at the Pan Am Games shooting baseball with her monopod

Photography by Angela McMullen
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Ron’s Blog

Hello APC Members:

Book of the Month
A Photographer’s Eye:
A Graphic Guide
by Michael Freeman
The Photographer’s Eye: A Graphic
Guide helps you understand
composition and design. The book
covers everything from framing and
placing your shot to juxtaposition to
showing motion within your photos.
Michael’s talent illustrates this with
diagrams helping you understand
how to better present your photos.
The book is very good at helping
you compose your images, and
demonstrates clearly how changing
the positioning of the image can
dramatically change the picture
you take. You will learn to position
a subject in a landscape to working
with circles, curves and diagonal lines
Why the point of view of a shot is
important, as well as how to position
moving objects in shot for visual
impact. Colour is important, the book
explains how different colour groups
can be used to create mood and give
visual direction in the photos.
This book helps new photographers
develop their “eye” to make better
decisions when setting up a shot.
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November is already here and
December is right around the corner.
With an unforeseen health issue we
had to switch our presenters for Nov
and Dec. Michael Willems stepped
in and help save the day, with a
great review on Composition and
Troubleshooting. He is a dramatic
speaker and a favourite at the APC.
He did a terrific workshop on Hands
ON-Off Camera Flash. It was dynamic
and practical. Learning 4 Exposure
Recipes that can be applied in
common lighting scenarios. We are
talking about making a part two
workshop in the New Year.
With Michael’s great presentation
Photo of Michael Willems & Leila by
Ron Pereux at Michael Willems Workshop
on Composition, classes will also be
following on the same topic. “The
difference between looking and seeing.” See this article on one of my
favourite photography websites:
Cambridge in Colour:
www.cambridgeincolour.com/tutorials/cameras-vs-human-eye.htm
There are many great articles here for reference. The next class will
be learning to apply, learning framing techniques, designing your
field of view. Bring in a prop for still life, we will be combining items to
make interesting images apply the rules, components and elements of
composition.
Later this month we will continue with post processing; learning the
foundations of Adobe Lightroom. It can be any of the recent versions,
learning to create your own workflow. Organizing images, basic editing,
exporting, watermarking, converting and naming your files. These are
very important for contest and competition submissions. If you have a
laptop, you can download a 30 day trial version from adobe.com or look
at leasing both LR and PS options. We will have follow up classes with
Adobe Photoshop Elements and intermediate and advanced classes in
Photoshop. We are confirming dates with instructors. Later we will explore
some external editing using NIK and Topaz software.
Future workshops in Lighting, Portraiture, Macro, Refraction, Aperture
Stacking, Freeze Frame will be scheduled as instructors and dates are
confirmed. More Classes in Black & White Photography, Learning the
Histogram, Product Photography soon to come.
Gary Ray Rush will be presenting on Jan 26th, Using the Zoning System
in your Photography. www.garyrayrushphotography.com/gary-ray-rushphotographer/zone-system
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Photoshop Tips
& Tricks
with Chris Noronha
Non-Destructive Vignettes in Photoshop

Love it or hate it, vignetting is a great way to direct
a viewers eye to your subject matter and avoid
distracting elements.

Technically speaking, vignetting is a decrease in
brightness of a photograph around its edges, usually
most apparent in the corners, which are furthest from
the centre of your photograph.

The following steps are how to add a non-destructive
vignette to your image in Photoshop.
• Select the Circle Marquee tool (located under the
Square Marquee tool, right click to select the Circle
one). Adjust the feather setting to about 200px.
• Inverse the selection from Select > Inverse (This
inverts the selection so that the outer edges of the
image are selected.

• Create a new curve layer by selecting it from Layer >
New Adjustment Layer > Curves.
• Darken it down. Add a point on the curve at about
the middle point and pull it down to your heart’s
content.
Since you are using an adjustment layer, you can
adjust the darkness at any time. The adjustment is
non-destructive to the image.
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Education and Workshops
with John Stafford
I am excited by all of the education and follow-up
workshops that Ron is conducting over the course of
the year. Ron is currently reviewing exposure and will
then move on to composition in his weekly education
sessions.

the Butterfly Conservatory in Cambridge which we are
just trying to firm up the dates on.

The next workshop is an off-camera flash workshop
with Michael Willem’s on November 14th at Rotary Park
which is sure to be both fun and informative.

We are always looking for new and interesting places
and events to shoot so if you think of something don’t
hesitate to message me in Meetup.

We have some outings in the works like the Raptor
Conservatory (birds of prey) with Peter Gatt and a trip to

I am looking for some winter events to shoot like
snow cross and snowboarding as well as some indoor
locations like the Trenton Air Force Museum.

The Photographic Museum of Ontario
by Peter Gatt
The concept of the Photographic Museum of Ontario
was formulated in 2009. The goal for the museum was
to show people, photography of the past (before the
digital era) with its many unique features, such as how
pictures were taken, and to show the future that digital
era will bring to us.

Why start a museum?
My wife and I were taking our children to the different
museums in Toronto to help educate them about the
past as well as help provide culture into their learning.
One day my youngest daughter asked me when we
could go see the Photography Museum to see how I
used to take and develop pictures when I was a child.
I told her that I didn’t know where the museum was but I
would look it up when we got home. To my amazement,
I couldn’t find a photographic museum anywhere in
southern Ontario. Ottawa has photo gallery that they
call a museum but it didn’t show cameras and the
development process. That’s when I thought that I
should start the Photographic Museum of Ontario here
in Toronto.
Where is the best place to have a museum? Well, the
old Kodak building on Photography Drive of course.
I have been working very hard to speak with the owners
of the property to propose my idea, and they love it.
Metrolinx, the owner, thinks it is a great idea and the
best thing for the building. They would have the
6

basement for the LRT and the museum would have the
remainder of the building. The only problem is that
Mount Dennis Community Association oppose the idea.
For some reason unbeknownst to me the MDCA has the
say to what business can occupy the building or not. I
even tried to get the local city counselor on my side as
well. At first Counselor Frances Nunziata was in favor of
the idea, but then MDCA convinced her otherwise.
The fight for the Kodak Building continues. We will
contact all the counselors and the mayor and bring this
decision to a vote. Not just on one small group and one
counselor. Here’s a view of what it will look like:
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APC Exhibits & Competitions
with Bob Wilson
January 8, 2016. We will use images from our 2015 year
end print competition.

Competitions

Our Fun Xmas Digital competition is now open for
submissions. One image per member, no category
restriction ( PG13 content ), self assign skill level as
Beginner, Intermediate, Advanced levels. Frans and I will
vet your categorization for the right category should you
make a mistake. Image should be about 1 - 3 meg in
size with a pixel dimension of 2560 on the longest side.
The deadline to submit a digital online image for
projection at the Xmas dinner at Deer Creek is Friday
November 27th midnight. Send one image with a title to
pixelbobapc@gmail.com. See meetup event for the
December 4th evening dinner and competition voted
on by attending members and guests.

Exhibitions

There is an ongoing member image display at Debbie’s
Boutique Cafe at 94 Harwood Avenue in Ajax.
We have an ongoing exhibit at the Rouge Valley
Hospital where we feature two of our member
photographers. Currently Sharon J. and Tim T. are on
display in the west fracture clinic. I am looking for two
different photographers to be featured. Please send me
an e-mail at r.003@sympatico.ca if you are interested.
We will be exhibiting member images at the McLean
Community Center from November 23, 2015 through to

GTCCC Inter-Club Competition will open for submission
on December 7th and closes January 5th, 2016. Rules
and image guidelines will be put on an APC meetup
event shortly. The rules have not yet been released by
the GTCCC Competition Committee as yet. There are
several new categories this year. I encourage members
to submit images from our 2015 year end competition,
others from our APC clinic, and the fun Xmas Digital
Competition. I suggest this approach as you will know
how your image has scored.
APC Year End Print Competition will take place in
May 2016. Details are yet to be established. Results will
be presented along with all of the entries in the May
member meeting. A meetup will be created with all of
the details in the New Year.

2014 Entries in the Fun Xmas Digital Competition

Driftwood by Chris Noronha

Beach by G.J. Baylon
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It’s Back!

Our Juried Photography Exhibition returns this Spring
AND will be a CONTACT Festival venue!
Our 2015 show gave total cash prizes in excess of $1,700 and
we hope to increase it in 2016!
• A maximum of 2 images can be entered by each entrant.
• Images are to be submitted electronically.
• For judging, all images will be placed in a single,
non-specific category.
Approximately fifty (50) images will be chosen for exhibition in
the Atrium of the Ajax McLean Community Centre from April 25,
to May 29, 2016. If selected for the show, the image will need
to be matted and framed, facemount to acrylic, or on gallery
canvas by the entrant.
We look forward to your participation in this Exhibition. Please
feel free to share this invitation and if you would like to print a
flyer or have us mail you one, please let us know.

Important Dates
Expression of Interest due:
February 26, 2016

Entry Acknowledgement:
March 6, 2016

Submission of Images Deadline:
March 14, 2016

Notiﬁcation of Acceptance:

Sincerely,
Susan Brown, Chair

April 5, 2016

Juried Photography Exhibition
siennasue01@gmail.com

April 24, 2016 - between 1 - 3 pm

Thank you for being part of our Juried Photography Exhibition!
To enter the 2016 show, an Expression of Interest form, needs
to be completed and received by February 26, 2016. The entry
form can be downloaded from the PineRidge Arts Council
website at www.pineridgearts.org/forms/2016/PhotoEntry.
pdf or you can register on line at www.pineridgearts.org/
jpe2016SignUpForm.html and pay with PayPal or cheque.
8

Delivery of Photographs:
Hanging Day:
April 25, 2016

Awards Presentation and
Opening Reception:
May 5, 2016

Pickup at Close of Exhibition:

May 29, 2016 - between 1 - 3 pm
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Capturing Light and Shadows
Full Education Day - April 2, 2016
This is an annual event is sponsored by the Greater
Toronto Council of Camera Clubs that is open to the
public. The GTCCC is an association of camera clubs that
service the Toronto and the GTA. Membership is open to
the public.
Capturing Light and Shadows is a full day learning
experience that provides you with 2 keynote speakers,
5 class tutorials to choose from and booking one studio
shoot from a choice of 2 subjects.

Registration includes all classes, refreshments, and lots
of giveaways.
Taking place at the Hilton Hotel & Conference:
8500 Warden Ave, Markham, ON
On Saturday, April 2, 2016
From 8:00 AM to 4:30 PM
Visit www.gtccc.ca for further information on joining
and activities.

Weegee: Murder Is My Business
October 14 – December 13, 2015
Curated by Brian Wallis, Former Chief Curator,
International Center of Photography, Main Gallery, Ryerson Image Centre
For an intense decade between 1935 and 1946, Weegee
(1899–1968) was one of the most relentlessly inventive
figures in American photography. His graphically
dramatic and often lurid photographs of New York crimes
and news events set the standard for what has become
known as tabloid journalism. Freelancing for a variety of
New York newspapers and photo agencies, and later
working as a stringer for the short-lived liberal daily

PM (1940–1948), Weegee established a way of
combining photographs and texts that was distinctly
different from that promoted by other more mainstream
picture magazines. This traveling exhibition draws upon
the extensive Weegee Archive at the International Center
of Photography, New York.
For more information visit: www.ryerson.ca/ric/
exhibitions/Weegee/

Weegee, Anthony Esposito, Accused “Cop Killer,” January 16, 1941, gelatin silver print © Weegee/International Center of Photography
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7 Days of Garbage
New Photo Exhibit at Union Station
The City of Toronto has opened an exhibition of
Gregg Segal’s expanded “7 Days of Garbage” series
of photographs in the Great Hall of Toronto’s Union
Station. The exhibit, co-sponsored by GLAD, showcases
seven days of each subject’s garbage as a way of
shining light on personal consumption and related
waste. The exhibit is on until November 22, 2015.

Now, GLAD is honoured to partner with the City
through its Live Green Toronto program, and acclaimed
photographer Gregg Segal, to spread the message of
sustainability and waste reduction through art.”

“As the City develops its long-term waste management
strategy, it’s important to engage more people in this
important issue,” said Councillor Jaye Robinson (Ward
25 Don Valley West), Chair of the Public Works and
Infrastructure Committee. “These powerful photos
challenge all of us to own the issue and be part of
the solution.”

By placing waste and personal consumption at
the centre of his lens, Segal’s thought-provoking
exhibition of photographs pairs life with art to spark
a conversation about the sheer volume of waste we
produce, and about the need for Canadians to adopt
more sustainable ways of life. Viewers are encouraged
to share their thoughts and insights on social media
using #7DaysofGarbage.
Segal’s photographs feature portraits of individuals,
couples and families surrounded by the garbage they
produce in one week. The people portrayed include
five prominent Torontonians: Kai Lee, restaurateur and
son of Canadian chef Susur Lee; Amanda Blakley, a
freelance writer and co-founder of exclusive Toronto
tastemaker’s club The Social; Andy Byford, chief
executive officer of the Toronto Transit Commission
(TTC); and James Yurichuk and Natey Adjei, members
of the Toronto Argonauts football team.
“We wanted to bring awareness to the amount of
garbage that Canadians are producing on a yearly
basis,” said Mike Pilato, General Manager of Clorox
Canada. “As a company, we have led a number of
sustainability initiatives from coast-to-coast, from
city-wide community cleanup days to awareness
campaigns around proper composting and
recycling practices.
10

APC Newsletter | November/December 2015

	
  
1450	
  Simcoe	
  Street	
  South	
  
1450	
  Simcoe	
  Street	
  South	
  
Oshawa,	
  ON	
  	
  L1H	
  8S8	
  
Oshawa,	
  ON	
  	
  L1H	
  8S8	
  
905-‐436-‐7624	
  ext.	
  106	
  
905-‐436-‐7624	
  ext.	
  106	
  

	
  

	
  
72	
  Queen	
  Street,	
  Civic	
  Centre	
   	
  
72	
  Queen	
  Street,	
  Civic	
  Centre	
  
Oshawa	
  ON	
  	
  L1H	
  3Z3	
  
Oshawa	
  ON	
  	
  L1H	
  3Z3	
  
905-‐576-‐3000	
  ext.	
  109	
  
905-‐576-‐3000	
  ext.	
  109	
  

Photography and History of the Manipulated Image

IMMEDIATE
RELEASE
FOR
IMMEDIATE
RELEASE
Oshawa Historical Society November SpeakerFOR
Series
OSHAWA, ON, October 27, 2015 – “Seeing is believing”
and “a picture is worth a thousand words” are common
idioms that have shaped and influenced the way
in which we have interpreted, weighed and valued
photographs in society. But what if these photographs
are not what they seem?

through the Oshawa Historical Society please visit

www.oshawahistoricalsociety.org.
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a greater
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about
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For
more
about
programming
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Museum
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through
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Society
please
visit
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Oshawa’s
early
inhabitants.
or through the Oshawa Historical Society please visit www.oshawahistoricalsociety.org.
905-576-3000 ext. 109
For more information about programming and
smogelonsky@rmg.on.ca
events at the Oshawa Community Museum or
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